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Revit Families

Revit projects use Revit families.

There are three types of families:

e System
e In-Place
e Loadable

System families are specific to a project. You can copy system families from one project to
another, but they are not stand-alone files, like loadable/model families. Examples of system
families are walls, conduits, wires, and ceilings.

In-Place families are elements which are created “on the fly” using massing tools. Users often
create an in-place family for a feature that is unique to a project. A generator or electrical
equipment that is specialized may be created using massing tools, so that users can see the
amount of space it takes up in a project.

Loadable families are the most common type of family. Examples include cable trays, power
devices, and electrical equipment. These are external files which are inserted/loaded into a
project and placed in the desired location. These families can be counted and their properties can
be organized in schedules. These elements can be created from scratch using the Family Editor
using family templates. They can be created and loaded into a project, as well as deleted or saved
from a project.

Revit families are defined using parameters. There are two types of parameters: Type and
Instance.
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Revit elements are defined by a hierarchy.

CATEGORY

FAMILY

INSTANCE

|_:_| Lighting Fixtures

- Plain Recessed Lighting Fixture
....... Txd - 120

....... 1xd - 277

....... 2x2 - 120

....... 2ud - 277

....... 2xd - 120

....... dwd - 277

------- 204 - 120

....... 20xd - 277

In the Revit Project Browser under the Families folder, you see the families organized into
categories. Lighting Fixtures is a Category. The Plain Recessed Lighting Fixture is a Family. A
family is an element that represents a specific component used in a project. Each Family can
have several different types. This lighting fixture has different types which are defined by size
and voltage. The family type doesn’t change regardless of where it is placed in the project. If
you place a 1x4 lighting fixture in the living room or the bedroom, it is still a 1x4 lighting
fixture.

Every time you place or define a family in a project, you are creating an “instance” of that
family. Location is an instance parameter. Hardware or finish can be unique to each family
places, so these can also be instance properties. Type properties are properties that are common
to all elements of that type. Instance properties are properties that are unique to each individual
element.
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Throughout the rest of the text, we will be creating new types of families.
Here are the basic steps to creating a new family.

Select the element you want to define (switch gear, receptacle, panel, etc.).
Select Edit Type from the Properties pane.

Select Duplicate.

Rename: Enter a new name for your family type.

Redefine: Edit the structure, assign new materials, and change the dimensions.
Reload or Reassign: Assign the new type to the element.

S

[ SELECT ELEMENT ]

Detail Items

Elements are the building blocks of any Revit Project. Everything used in a Revit project is
considered an element.
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There are three classes of Revit families:

e Model
e Datum
e View-Specific.

Model families are families which you can physically touch if you were walking through a
building, such as walls or electrical panels. A host model family is an element which can be
used to hold or place other components. For example, a wall can host a door, window, or
electrical panel. An element which is placed on a host is considered a component. Datums are
levels, grids, and survey points. They are used to constrain the project. View-specific families
are annotations, like dimensions or text, and detail items, like filled regions

Non-hosted families can be placed anywhere in the view. They are typically placed aligned to
the elevation of the view. If you need to offset them from the elevation, place the element in the
view, then select it, then change the offset from elevation value in the Properties palette to the
desired location.

Hosted families must be placed on a surface or work plane and the surface must be visible in the
view. If a fixture needs to be placed on a ceiling, the view needs to be a ceiling plan. Check on
the ribbon to specify the type of face to be used for placement. If the placement face is deleted,
any elements hosted by the face will also be deleted. If the placement face is moved, then the
elements will also move.

Electrical Devices

The workflow to add electrical devices.

Select a category of family to add to the model on the ribbon.

Use the Type selector to choose the exact type in the category.
Place it as required on a vertical, horizontal, or work plane face.
Adjust the instance properties of the family in the Properties palette.
Tag if needed.

A G e S
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Some guidelines when working with Revit families to help you work efficiently:

e Familiarize yourself with the content libraries which come with the software as well as
the libraries used within your company. Then, when you are looking for a specific
family, you might be able to use or modify an existing family.

e  When you modify a Revit family or element, save the family under a new name and save
it to a custom library location, preferably on your company’s server. This will make the
family type available across projects as well as to other users in your company.

e Avoid accidentally selecting elements in a view so they don’t get modified.

e Ifyou hover your cursor over an element, a small dialog will appear informing you of the
family and type.

Lighting Fixtures

Lighting fixtures follow the same workflow as other electrical devices and are powered the same
way. They also have the ability to calculate an average estimated illumination level for spaces.

When loading light fixture families, make sure to pull them from the MEP folder, not the
Architectural folder.
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Exercise 2-1:
Working with Revit Families and Elements

Drawing Name: elements.rvt
Estimated Time: 20 minutes

This exercise reinforces the following skills:

o Identifying elements and their families in a project
a Place a Component

1 Architecture | Systems  Insert  Annotate

@ ‘Opens a Revit-compatible file.

Open elements.rvt.

This file is downloaded from the publisher’s website.

ens
E Open 3 @ Family

Opens a Revit family.

2. - Hectc Open the Level 2 Lighting Plan.

- Lighting
... Floor Plans

----- Level 1 Lighting Plan
evel 2 Lighting Plan

evel 3 Light Plan

i North Level 1 Lighting Plai

3. Zoom In Region Right click and select Zoom In Region.

Zoom Qut (2x)

Zoom To Fit
4. (5 tever 2 ighting Plan Draw a rectangle/region in the upper left corner of the
1 ot building.
AT 2
-
————
J= 4 T
5. - Hover the cursor over one of the lighting fixtures labeled
[ Lighting Firtures : Pendant Lighting Fixture : 1x4 - 277V | ¢ C ’ .
/ / ‘ I Note that the family and type are displayed.
6. Pan down.
= ;‘ Hover the cursor over one of the lighting fixtures labeled
T ‘B’.
= l:—“L" Note that the family and type are displayed.
— 41 The ‘B’ and ‘C’ lighting fixtures are the same family, but

different types.

2-6



Revit Families

7 =t -
o
¥

8 . Properties X g

Pendant Lighting Fixture -

Ixd - 277V

Liohtin Fixtures (1) | AR Edit Type
. - \= .

9, Properties x &

Pendant Lighting Fixture
1xd - 277V /

| O3 Fdit Tune

e

vy | g g

10.

Properties

| s e

X i

Pendant Lighting Fixture
x4 - 27TV

Search
] .
o Pendant Light - Disk
100W - 277V

/ Pendant Lighting Fixture

F2)

1xd - 277V

| te-zrv |

11.

12.

|_-—_| Coordination

- Lewel

b Ll 1

2

Level 3

M
i

M
)

M
as}

M
|

M
i

Select the ‘C’ lighting fixture that is located on the upper
left.

Note that the Family and Type are displayed in the
Properties panel.

Select the small down arrow located at the top of the
Properties panel.

This is called the Type Selector.
Select the 1x8-277v from the Type Selector list.

Press ESC to release the selection.

Notice that the element is updated to the new type which
you selected.

Open the Level 2 view under Ceiling Plans.

Look in the Coordination category.

Note that the lighting fixture which was changed in the
previous view updated in this view.

Revit has bi-directional associativity. This means that if
you make a change to a model element in one view, the
change is propagated throughout the model. All the views
update.

This only applies to model elements — NOT to annotation

elements. Annotation elements, like dimensions and notes
— are view-specific.
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13.

14.

15.

16.

17.

18.

19.

© e Legenu
28 Schedules/Quantities (all)

------- Electrical Circuit Schedule

------- Level 1 HVAC Zone Schedule
------- Level 2 HVAC Zone Schedule
------- Level 2 Space Airflow Schedule
....... Level 2 Space Schedule

....... Level 2 WSHP Schedule

....... Lighting Fixture Schedule
Space Lighting Schedule

E| ----- Electrical
.. Lighting
- Floor Plans

- Level 1 Lighting Plan
evel 2 Lighting Plan
Level 3 Light Plan
- Morth Level 1 Lighting Plai
- Sections (Building Section)
- Section 17
... Section 18

Electrical Equipment : Lighting and
Panelboard - 430V MLO - Surface :

Appliance
Lp-2

View  Manage

]
]

Tile
Wiews

Open the Lighting Fixture Schedule view.

The schedule is a view-element. The light fixtures are a
component/model element.

Notice the quantities for Type Mark A and Type Mark B.
These quantities updated when the fixture was changed.
Open the Section 18 view under Sections (Building
Section).

Hover your cursor over one of the electrical panels.
Note that the family and type are displayed.

Select the View tab on the ribbon.

Select Tile Views.

The four open views are tiled.

e

Click in the upper left window to activate it.
Double click on the mouse wheel to Zoom
All

Repeat for the other windows.
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g v v

A B

Type Mark Family and Type

A

Recessed Parabolic Light: 2'x2'(2 Lamp) - 277V

T5

B

Pendant Lighting Fixture: 1x8 - 277

Pendant Lighting Fixture: x4 - 277/ |
i )

E

Sconce Light - Flat Round: 80W - 277V

Grand total: 378

1

—

i

21. Close without saving.

In the window with the schedule:
Put your mouse in the field for Family and

Type for the ‘C’ type mark fixture.

Notice how the lighting fixture is highlighted
in the other windows.

Many electricians need to determine the location of the stud framing in a wall as they are routing
their wiring between the studs. Most Revit projects created by electrical workers are defined by
using a host project which links to the files provided by the architect and the other sub-

contractors. It is helpful to be able to select elements that reside in the linked file, so you can
identify them and determine how they are defined.
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Exercise 2-2.
Identifying a Wall in a Linked File

Drawing Name: simple-building.rvt
Estimated Time: 10 minutes

This exercise reinforces the following skills:

o System Families
o Revit Links
o Walls

1' Architecture = Systems  Insert  Annotate O en Sl'm le_bul'ldl'n ,I"Vt,
Opens a Revit-compatible file. p p g

L | S seewnn This file is downloaded from the publisher’s website.
(=% open v @ Family

Opens a Revit family.

2. This project uses a Linked Revit project.
= Open the Insert tab on the ribbon.

Links Select Manage Links.

3. Revit | IFC CAD Formats  DWF Markups — Point Clouds The linked file is named Slmp le-

Building-Arch.rvt.
Link N Stat )
e Tame T Because the files are now in a new
Simple-Building-Arch.rvt Mot Found i€ ]ocation, the link has to be re-
established.
Select Reload From.
4. File name: | Simple-Building-Arch.rvt Locate the file in the downloaded files

_ . from the publisher’s website.
Files of type: |RVT Files (*.rvt)

Select Open.
5. - : The file now shows as loaded.
Link Mame Status
Simple-Building-Arch.nt :Loaded C Click OK to close the dialog.
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6. In the lower right hand corner of the
L8 B M O o display are selection tools.
[y I
The link tool allows you to select
elements which are linked to the host
file.
=15
The select underlay tool allows you to
select elements which are part of the
linked file.
7. —
T 1 See if you can select the right vertical wall using the TAB key.
AL
l/“
5 =
8. Properties x | On the Properties palette, select Edit
Type.
| Walls (1) ~| £3 Edit Type
Constraints .k A
9. . Select Edit next to Structure.
vpe Parameters
Parameter | Value
Construction i 1
Structure [ Edit...
Wrapping at Inserts Do not wheg——-"y
Wranninn at Fadc Mane
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1 0 . Family: Basic Wal
Type: Generic - 8"
Total thidness: o' 8" Sample Height: 20" o"
Resistance (R): 0.0000 (h-ft2-°F)/BTU
Thermal Mass: 0.0000 BTU/*F
Layers
EXTERIOR. SIDE
Function Material Thickness  [Wraps Sualel

Material

1 |Core Boundary
Structure [1]

Layers Above (0" 0

<By Category

3 |Core B Y

Layers Below 0" 0"

INTERIOR. SIDE

11. Press OK twice to close the dialogs.
12. Left click in the window to release the selection.

13. Close the file without saving.
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You see how the wall has been defined
by the architect.

Notice that it has an exterior side and
an interior side.

The Core boundary is the boundary
around the stud or framing. Anything
outside of the core boundary is
considered a wrapped layer and is
usually a finish, like gypsum board or
siding.
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Exercise 2-3:
Place a Lighting Fixture and a Switch

Drawing Name:

Estimated Time:

simple-building.rvt
10 minutes

This exercise reinforces the following skills:

o System Families
o Revit Links

o Walls
1 ""““ e et vt Open simple-building.rvt.
L | S seewnn This file is downloaded from the publisher’s website.
Fedial | [t
2. = Electrical In the Project Browser, activate/open
& Lighting the 1-Ceiling Elec Ceiling Plan.

1 - Lighting
2 - Lighting
EI ----- Ceiling Plans
-1 - Ceiling Elec
. 2 - Ceiling Elec
[N ; P
Systerns ST o R e e s e T e T | Activate the Systems tab of the ribbon.

Wire Cable Conduit Parallel Cable Tray Conduit | Electrical Device

FomE o B ﬁ
Lighting
Fiture

Tray

Conduits  Fitting  Fitting | Equipment

Select Lighting Fixture.

Electrical

4. e Recessed et b Use the Type Selector to select Plain Recessed
/ Pl Recessed Lighting "“;,- Lighting Fixture:2x4 — 277.
bearch - The Type Selector is the small down arrow located
& Plain Recessed Lighting Fixture to the right of the family name. The Type Selector
1xd - 120 is used when a family has more than one version
1xd - 277 available.
2x2 - 120
2x2 - 277
2xd - 120
2x4 - 277
204 - 120
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Modify | Place Fixture -

d=- 1[0 G Ey

=
v

Load Model
Family In-place

Mode

S L

Measure Create

&

Place on

(&) ©

Vertical Face

Place on| Place on
LFace [Work Plane

P

lacement

|
t

n

@ Systems

|_:_| Electrical
= Lighting

EI ----- Ceiling Plans

... 2 - Ceiling

Insert  Annotate  Analyze

Flm E
Wire

Tray Conduits ~ Fitting

Electrical ="

x [ 1-Mech

-

g « | HF Edit Type
Ao

96

MNormal

2 - Lighting

The ribbon has changed to a contextual
style.

Enable Place on Face.

This means the fixture will be hosted by
a work plane.

Use the SPACEBAR to rotate the light

fixture.

Place two lighting fixtures in the upper
left room.

In the Project Browser, activate/open the 1-Lighting
floor plan.

Notice you see the lighting fixtures you placed in the
ceiling plan. This is because Revit is a BIM software. If

you make a change to the model, any relevant views

Elec

1- Ceiling Elec  will update.

Collaborate  View  Manage A«

® % M

Cable Conduit Parallel Cable Tray Conduit

Fitting

Equipmest#*= =
"

Device

Electrical

[ 14

Electrical Fixture

J Y

(A} Communication
E‘ﬁ Data

@ Fire Alarm

Lighting

I:II:I':I Nurse Call

1

Li
F

Lic

Activate the Systems tab of the ribbon.

Select Lighting under the Device drop-
down list.
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10.

11.

Properties X
Lighting Switches 4
Single Pole

|Search el

' Lighting Switches

Circuit Breaker
Dimmer

Deoor

Four Way

Key Cperated
Low Veltage
Pilot Lighted

| Single Pole

Three Way

120V

Other

Properties

Lighting Switches
Single Pole

4

New Lighting Devices v | B Edit Type

Constraints

-
-

Schedule Level Level 1

Elevation from Lewvel:d" 0"

Host =<not associated:>

Offzet from Host o0

Electrical
Switch Voltage 120,00V

>

Electrical - Lighting
Switeh 1T

T

A

Use the Type Selector to select
Lighting Switches — Single Pole.

Place the switch to the left of the door
in the upper left room where the
lighting fixtures were placed.

Note that the Elevation from the Level
is set to 4°-0”.

Save the project as ex2-3.rvt.
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Exercise 2-4:
Select and Modify a Component

Drawing Name: modify.rvt

Estimated Time: 5 minutes

This exercise reinforces the following skills:

a Filter
a Type Selector

1 Architecture | Systems  Inset  Annotate

[ wew , ﬁ Project

(=% open v @ Family

Opens a Revit-compatible file.

Opens a Revit project.

Opens a Revit family.

2. Manage Links

Revit  IFC CAD Formats DWF Markups  Point Clouds 1

Link Name

Status

Simple-Building-Arch.rvt

Loaded

3. |_:_| Electrical
=) Lighting

= Floor Plans
. .1 - Lighting
. 2 - Lighting
- Ceiling Plans
.1 - Ceiling Elec
.. 2 - Ceiling Elec

— T

=

U

5.
D‘_ |I_/ Face

Pick
Mew

e Placement

A g

Filter

Sele

Open or continue working in ex2-3.rvt.

If you open the modify file, remember you have to
reload the linked file.

In the Project Browser, activate/open the 1-Lighting
floor plan.

Left click at the upper left corner of the room with the
lighting fixtures. Hold down the left mouse button to
create a window.

Left click at the lower right corner of the room with the
lighting fixtures.

This creates a selection group using a window.

Select the Filter tool from the ribbon.
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Filter Uncheck any items in the list except for Lighting
Category: Count: FiXtureS.

O ghng Devices

Rarshmo Fres ’ Press OK.
Properties ' x Use the Type Selector to change the lighting fixtures to
/ Plain Recessed Lighting Fixture _ 1x4 - 277.

2xd - 277

— 5> Press ESC to release the selection.

@ Plain Recessed Lighting Fixture
Txd - 120
[ va-am
— —. The lighting fixtures update.

Save the project as ex2-4.rvt.
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Exercise 2-b
Copy a Component

Drawing Name: copy.rvt
Estimated Time: 5 minutes

This exercise reinforces the following skills:

a Copy
a Type Selector

1. Architecture LGN Open copy. rVvi.

e
ens a
% Open v | O ] Family

Opens a Revit family.

2. &~ Electrical In the Project Browser, activate/open the 1-Ceiling

& Lighting Elec Ceiling plan.
[SE Flocr Plans

E| ----- CElImg Plans

: -1 - Ceiling Elec

e 2 - Ceiling Elec
3. Window around the first room to select the two lighting
- fixtures.

4. Select the Copy tool on the ribbon.
|:| I :
= & Dl Bl :
4+ 0 == °r
1y [0S r -
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Select the top left corner of the first room as the base
point.

Select the top left corner of the second room as the
target point.

Save the file as ex2-5.rvt.
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Exercise 2-60:
Mirror a Component

Drawing Name: mirror.rvt
Estimated Time: 5 minutes

This exercise reinforces the following skills:

o Mirror=>Draw Axis

1 Architecture | Systems Insert  Annotate

Open mirror.rvt.
E ‘Opens a Revit-compatible file. p

E Open » @ Family

Opens a Revit family.

2. &~ Electrical In the Project Browser, activate/open the 1-Ceiling
Elec Ceiling plan.
-2 - Lighting
B Ceiling Plans
-1 - Ceiling Elec
. . 2 - Ceiling Elec
3. Window around the lighting fixtures to select them.

4, D:I & DI[Q Select the Mirror->Draw Axis tool.

+ O —
=
o i"
Modify
5. Select the top of the center line of the wall.

Select the bottom of the center line of the wall.

6. The light fixtures are mirrored to the other rooms.

Save as ex2-6.rvt.
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Exercise 2- 7
Align a Component

Drawing Name:
Estimated Time:

align.rvt
5 minutes

This exercise reinforces the following skills:

o Align
1 Architecture | Systems \n-sart Ar:motate Open align‘ }"vt‘
@ ;ap'::);aRemtfamMy‘
2. In the Project Browser, activate/open the 1-Ceiling
e Elec Ceiling plan.
-1 - Lighting
. L..2-Lighting
E ----- Ceiling Plans
-1 - Ceiling Elec
i 2 - Ceiling Elec
3. MEE '”D”amm: visw Select the ALIGN tool on the Modify ribbon.
& PiI Dl
O3 ==
o i
Modify
4. Select the ceiling grid line to the left of the lighting fixture.
Select the left edge of the lighting fixture.
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5. | The lighting fixture’s position adjusts.
|

6. Use the ALIGN tool to

adjust the position of the
lighting fixtures so they N N m

are aligned to the ceiling
grid.

Save as ex2-7.rvt.
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Exercise 2-8:
Draw, Modify, and Offset Cable Trays

c
3

Drawing Name:
Estimated Time:

able_trays.rvt
0 minutes

This exercise reinforces the following skills:

Cable Trays
Offset

Trim

Split
Options Bar
Properties

0O000D0 DO

Architecture  Systems  Insert

Annctate

fS=]
»

[ o
[== open

i
=l

» Family

Opens

Cmm

B0, View
=) Electrical

a4

Cable
Tray

r

Wire
b

s (Discipling)

Systerns  Insert  Ann

Open cable_trays.rvt.

Opens a Revit-compatible file.

Project
Opens a Revit project.

a Revit family.

In the Project Browser, activate/open the 1-Power floor
plan.

i1 - Lighting
-2 - Lighting
B Ceiling Plans
{ i1 - Ceiling Elec
2 - Ceiling Elec

Activate the Systems ribbon.

Conduit

Select the Cable Tray tool.
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Properties

|Sec. rch

Cable Tray with Fittings
Channel Cable Tray

Cable Tray with Fittings

s Channel Cable Tray
“2~ Ladder Cable Tray
: Sclid Bottom Cable Tray
s Treugh Cable Tray
‘@ Wire Mesh Cable Tra;'

Select the Trough Cable Tray from the Type Selector.

On the Options bar:

- iimy
Width: | 6"

v| Height:| 2"

Set the Width to 6”.

Set the Height to 2”.

Set the Middle Elevation
to 10°-0”.

Left click to place the
start of the cable tray at
the left side of the
corrider (indicated by 1).

Left click to place the end '

v]'| Middie Elevation: [ 10" 0* ] ]|

NNWM IM

of the cable tray at the
right side of the corrider
(indicated by 2).

ol

-

y

Press ESC to complete placing the tray but remain in the Cable Tray command.

Place a second cable tray perpendicular to the first
cable tray and into the Mech/Elec room (lower left).

Right click and select Cancel to exit the command.
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9.

11.

12.

13.

This is what the layout R
should look like. 1 I I I
ST — <
L/
EU:{ == Select the vertical cable tray so it is highlighted.
[ TE————
iy
O | Select the Offset tool.
o\ bidl Dl
4+ Cn O =
o i
Modify
On the Options bar: T e T —
) () Graphical (@ Mumerical Offset:| 15' 0" |ECDP}T

Enable Numerical.
Set the Offset to 15°-0”.
Enable Copy.
| g pg

Left pick the cable tray.

the right.

2-25
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14. Repeat the Offset to place : o WY I [ Uy
a total of five vertical = : '
cable trays. - ; | )
™~
AN o

15. Select the Trim to Corner tool on the Modify ribbon.
O | y
= & Bl Bl

+ O ="
=
%30
M
16. Select the horizontal cable tray and the far right cable
tray.
P 0N
17. The two cable trays are joined.

-

. ||:||:| e Dllg Dlﬁ ;: so 43 On the Modify ribbon:
4+ o :—_»lh oo E 42

2 "o 2Ex  Select the Trim/Extend Multiple tool.

1

o0

Modify

=

19. Select the lower line of
the horizontal cable tray ™~

to define the boundary of ' ﬁﬁ
the trim.

20. Left pick to the right of

the fourth vertical cable e

tray to start the '
selection/crossing \ﬂ_ _

window. :
Left pick to the left of the
second vertical cable tray
to complete the
selection/crossing
window.
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21. This is the cable tray
layout so far.

| S — S ———— E— i S——— ——

Select the Split tool on the Modify ribbon.

22. | )
B & bl pla- =

4+ O ==
GO aax

Modify

23. ' Use the temporary dimension to split the cable tray 7’-
0” from the end.

Y,
. Right click and select Cancel twice to exit the

command.

24. Select the lower part of the cable tray.

L I _‘\ r_J_ I
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uuuuuuuu

25, | wwn[e ] neap [ <] |" On the Options bar:

Set the Width to 4”.

26. Save as ex2-8.rvt.
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-xercise 2-9;
Place Light Fixtures and Switches (reprised)

Drawing Name: i elec circuits.rvt
Estimated Time: 20 minutes

This exercise reinforces the following skills:

o Place Components
a Copy

1' Architecture = Systems  Insert  Annotate O en l elec Cll"CMltSVVt
E Opens a Revit-compatible file. p - -

D New 3 m Project
Opens a Revit project.
e ooen ] L) o

Opens a Revit family.

2. Reit Fc  canromas owrmaip L NS file uses RME Imperial-Arch as the linked file. Use
= the Manage Links tool on the Insert tab to reload the file,

Link Name Status ;
if necessary.
RME Imperial - Arch.vt Loaded

3. & Plans Verify that you are in the 34 Floor Ceiling Plan view.

2nd Floor Ceiling Plan
3rd Floor Ceiling Plan

4. Use Zoom In Region to change the
@ Meating @ Classroom 3 @ display to focus on Classroom 5 Room
\
|

307 between Grids 5 and 6.

|

|

|

|
B e e i
Systems  Insert Annotate  Analyze Collaborate  View Manage Add-lns | Activate the Systems tab Ofthe ribbon.

I mE e W
Lighting
Fixture

Wire Cable Conduit Parallel Cable Tray Conduit Electrical ~ Device
Tray Conduits ~ Fitting  Fitting | Equipment

Select Lighting Fixture.

Electrical
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Use the Type Selector to select Plain Recessed

6.
/ ot oy e BT o ] johting Fixture:2x4 — 277.

pal

|Searr:h 4

@ Plain Recessed Lighting Fixture

Txd - 120
Txd - 277
2x2 - 120
2x2 - 277
2xd - 120

P The Type Selector is the small down arrow located
to the right of the family name. The Type Selector
is used when a family has more than one version
available.

| 2a-2m7

2004 - 120
7 Modify | Place Firture =~

T m @
_ =
= =
. T Loa.d Model
Family In-place

The ribbon has changed to a contextual

5 (&) © style.

Placeon [Placeon] Placeon
Vertical Face| L Face |Work Plane

v Measure Create Mode

Placernent

Enable Place on Face.

This means the fixture will be hosted by
a work plane.

Use the SPACE BAR to rotate the component prior to

o~

placing.

/

Left click to place in the upper left area of the room.

Select the light fixture you just placed.

=

10. =  Select the Copy tool from the ribbon.

. -

| Left click to select the upper left corner of the light fixture
as the base point.

‘ Move the cursor to the right and type 8’ for the distance.

Press ENTER or left click to complete the copy.

1 MHHHHHIIHIH\‘HH\HHHHHH/

Repeat to place a third light fixture 8’ to the right of the

- — o -

Sy

copied/second light fixture.
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13.

14.

15.

16.

17.

18.

19.

20.

-

I O

I O s s e

I
I
i \
I

R AR

- Lighting

B Floor Plans

1st Floor Lighting

2nd Floor Lighting

3rd Floor Lighting Plan

= o e [T

a1

ce Lighting | Component
Fixture T

@ Place a Component

Properties X

—

——,
} Sconce Light - Flat Round
100W - 277V

bearch / £
500 A ~

Lighting Switches

Four Way
Key Operated
Low Voltage
Pilot Lighted

Single Pole
l Three Way

Save as ex2-9.rvt.

Use the CTL key to select the three light fixtures.
Use the COPY tool to place a copy of the three fixtures 8’
below them.

Repeat to place a third row of light fixtures 8 below the
second row.

The room should show a total of nine light fixtures.

Open the 374 Floor Lighting floor plan.

Select Component->Place a Component.

Use the Type Selector to locate the Lighting
Switches> Three Way.

Place a light switch next to each door located at the south
wall of the room.
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—xercise 2-10;

Adding and Modifying Equipment, Devices
and Fixtures

Drawing Name: adding elements.rvt
Estimated Time: 20 minutes

This exercise reinforces the following skills:

Place Components
Electrical Equipment
Load Families

Type Selector
Naming Equipment

000D DO

1 Architecture | Systems  Inset  Annotate

E ‘Opens a Revit-compatible file.

D] e » Project
Opens a Revit project.

[== open » @ Family

Opens a Revit family.

Open adding elements.rvt.

2. 4. ;,T:: }T;CT Verify that you are in the Main Floor — Power floor plan
- Main Floor - Dining Room view.

Main Floor- Power

Main Roof

Main Roof - Building 1

- Site

3. 7 I ; _ Zoom into the Electrical Room: 215.

Electrical

C
C

| I
4. Systems Activate the Systems ribbon.

5. ﬁ Select the Electrical Equipment tool.

LAt

Electrical
Equiprment

6 No Electrical Equipment family is loaded in the PI‘GSS Yes

project. Would you like to load one now?
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7. Libraries Browse to the Distribution folder under US
US T ial . . .
e Imperial\Electrical\MEP\Electric Power.
Electrical
MEP
Electric Power
| Cistribution
8. [ Lighting and Appliance Panelboard - 208V MCB.rfa Hold down the CTL key to make a
@Lighting and Appliance Panelboard - 208V MLO - Surface.rfa . .
[ k= Lighting and Appliance Panelboard - 208V MLO.rfa mUItlple selection.

@Lighting and Appliance Panelboard - 480V MCB - Surface.rfa

@Lighting and Appliance Panelboard - 480V MCB.rfa . . .
@Lighting and Appliance Panelboard - 480V MLO - Surface.rfa SeleCt nghtll’lg and Appllal’lce

‘¥l [z Lighting and Appliance Panelboard - 480V MLO.rfa Panelboard — 208 VMLO and nghtlng
@Metering Switchboard.rfa .

< and Appliance Panelboard — 480V
File name: | Lighting and Appliance Panelboard - 430V MLO.rfa MLO.

w | Files of type: |AII Supported Files (*.rfa, *.adsk)

Press Open.
0. iz > On the Properties palette:
. Lighting and Appliance
Panelboard - 208Y MLO
254 Verify that the Lighting and Appliance Panelboard —
New Hectrcal Equipment v| Efi Etyee D)8 MT,(0-2254 is active.
Constraints 4 .
Schedule Level Main Floor
N A This is a face-based component, meaning it needs a

Offset from Host o vertical or horizontal face to be placed. Since it is a
hosted component, if the wall where it is placed moves, it
will also move.

10. Place it on the east wall of Room 215.
Type ESC out of the command.
11, Fropetes X Select the panel that was just placed.
. Lighting and Appliance
Panelboard - 208V MLO hd
104 On the Properties palette, note the elevation from the
[Electrical Equipment (1] ~ Hg Edit Type level.
Constraints A oA
Schedule Level Main Floor
e T Left click anywhere in the display window to release the
L I I selection.
ectrical Engineering A
12, ‘Toeete X Select the Electrical Equipment tool.

‘ Lighting and Appliance

Panelboard - 480V MLO -

=08 _ Using the Type Selector:

Nevdlcticalsqupment | BB EYee | Qolect [ ighting and Appliance Panelboard — 480V MLO

onstraints L

Schedule Level Main Floor 250A.
Elevation from Level 40"

Host <not associat...

Offset from Host 00"

Note that by default it is located at the same elevation as
the other panelboard.

‘lectrical Engineering A
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13.  Electrical . Place the Lighting and Appliance Panelboard — 480V

o MLO 2504 above the other panelboard close to the door
m " L with a space between the two elements.

14. ﬁ Select the Electrical Equipment tool.

Electrical
Equipment

15. EI Select Load Family.

Load
Family |

16. . [camamaiasmam Browse to the Generation and Transformation
O] Neme : folder.

@ Diesel Emergency Power Generator.rfa
[z Dry Type Transformer - 480-208120 - NEMA Type 2.rfa

i Dry Type Transformer - 480-208Y120 - NEMA Type 3o Select the Dry Type Transformer — 480-208Y120-

@ Dry Type Transformer - 12000-208Y120 - NEMA Type 1.rfa

B8 ey o Gt NEMA Type 2.
Press Open.
17. | FProperies *  Use the Type Selector to select the 45 kVA type.
. D e
45 kVA
18. ’ Place the transformer next to the panelboards in Room
Electrical 215.

\21—5/ N { Use the SPACEBAR to rotate the element prior to
placing.

Escape out of the command.
" Remember that if you hover the cursor over an element a
tooltip will appear showing you the element information.

Electrical Equipment : Lighting and Appliance
Panelboard - 208Y MLO: 225 A

’ND!'IE
19. | Generi : +  Select the 208V MLO panelboard.
Mounting Recessed
Enclosure Type 1 .
Panel Name LPT In the Properties palette:
Location Corridor 214

Scroll down to the General area.
Type LP1 in the Panel Name.
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20.

21.

22.

Phase Uemaolished iMone H
General A
Mounting Recessed
Enclosure Type 1
Panel Name HP1
Location Corridor 214
Fropernes A

Dry Type Transformer -
480-208Y120 - NEMA Type 2
45 kVA

| Electrical Equipment (1)

Image -
Comments
Mark 4
Phasing 2
Phase Created iNew Constru...|
Phase Demolished iNone :
General H
Enclosure Type2
Mounting
Panel Name LA v
Location Electrical 215

Elartriral - Cirriikine

Save as ex2-10.rvt.

v| Edit Type :

Select the 480V MLO panelboard.
In the Properties palette:

Scroll down to the General area.
Type HP1 in the Panel Name.
Select the Transformer.

In the Properties palette:

Scroll down to the General area.
Type T1 in the Panel Name.
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Exercise 2-11:
Adding Receptacles

Drawing Name:
Estimated Time:

receptacles.rvt
15 minutes

This exercise reinforces the following skills:

000D

Place Components
Electrical Fixture
Load Families
Type Selector

Architecture | Systems  Insert  Annotate

@ ‘Opens a Revit-compatible file.

\2] e » Project
Opens a Revit project.

E Open » @ Family

Opens a Revit family.

). Main Floor

... Main Floor - Dining Room
Main Floor- Power

Main Roof

Main Roof - Building 1

Site

rate T Wiew'  wanage A

) ¥ B |

uit Electrical | Device [L
ig | Equiprment - |

Electrical Fixture

Revit X

No Electrical Fixtures family is loaded in the
project. Would you like to load one now?

RVT 2021
Libraries
US Imperial
Electrical
MEP
Electric Pawer

Open receptacles.rvt.

Verify that you are in the Main Floor — Power view.

Activate the Systems ribbon.

Select Device-> Electrical Fixture.

Press Yes.

Browse to the Terminals folder under Electric Power.
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10.

1.

12.

13.

File name: | Duplex Receptade.rfa

Fles of type: | Al supported Files (*.rfa, *adsk)

Properties. x [

Duplex Receptacle i
GFCI

v| Edit Type

PR

0 Qo

New Electrical Fixtures

Q
M

)
en's Tollet Roo

212

S
CET [

Women's Toilet
Room

213
o s

view vianage M

) M B

uit Electrical | Device |L
ig | Equipment T |

Electrical Fixture

rate

Properties

Duplex Receptacle
Standard

Sleeping Quarters Sleeping QuartersSleeping Quarters Sleeping Quarters
201 202 203 204

Save as ex2-11.rvt.

Select the Duplex Receptacle.
Press Open.

Select the GFCI type from the Properties palette.

Place a GFCI receptacle next to each of the sinks in the
lavatories.

Note that the receptacles are hosted by walls. You do not
see the models unless you hover over a wall.

Select one of the receptacles that was placed.
Note the elevation of the receptacle in the Properties

palette.
Select Device->Electrical Fixture.

Select the Standard type from the Properties palette.

Note the elevation of the receptacle in the Properties
palette.

Place four receptacles in each of the sleeping quarters as
shown.
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Exercise 2-12:
Create a New Family Type

Drawing Name:
Estimated Time:

receptacle family.rvt

20 minutes

This exercise reinforces the following skills:

0O000D0 DO

Place Components
Electrical Fixtures
Load Families
Type Selector
Type Properties
New Type

1 Architecture  Systems  Insert  Annotate

[ tew

»

(=% Open

»

ey

2_ E| Floor Plans

Opens a Revit-compatible file.

m Project
Opens a Revit project.

] Famiy
Opens a Revit family.

------- Ground Floor
------- Ground Floor w Dimensions
Lower Roof

= Main Floor
Main Floor - Dining Room
Main Floor- Power

Open receptacle family.rvt.

Open the Main Floor — Power floor plan.

In the Project Browser:

Scroll down to the Families category.
Locate the Electrical Fixtures folder.
Locate the Duplex Receptacle family.

There are currently two types:

e GFCI
e Standard
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Annotation Symbols . . .
4 el Highlight the Duplex Receptacle family.
----- Casework . .
Ceitngs Dot Right click and select New Type.
Conduits Rename...
----- Curtain Panels Edit
Curtain Systems
Curtain Wall M SauEs
----- Detail ltems Reload...
Doty | S0
..... Ducts Expand All
..... Electrical Equipt Collapse Selected
=)- Electrical Fixture Collapse All

S ciZel
Standard

Name the new type TV.

Match Right click on the TV type.

Type Properties...

&l Electrica

=1 Dupl Search... .

4 Expand All SeleCt Type Propertles.
Collapse All

7. Twe S— Set the Default Elevation to 7° 6”.
Parameter Set the Load to 600.00 VA.

Default Elevation 76

Switch Vaoltage 120,00V
Load Classification Receptacle
Load 600.00 VA

8. — Scroll down to the Other category.
Label TV

f Locate the Label field.
Set the Value to TV.
Press OK.

Annotation Symbols . . .
9 S Highlight the Duplex Receptacle family.

----- Casework . .

Cings e Right click and select New Type.

Conduits Rename...
----- Curtain Panels
..... Curtain Systems E91

Curtain Wall M SauEs
----- Detail ltems Reload...
----- Deors

Duct Systems SEin
..... Ducts Expand All
..... Electrical Equipr Collapse Selected

=)- Electrical Fixture Collapse All
=]
- GFCl
Standard

[ LIS L Ll LA RS

10. Name the new type EWC.

El ----- Electrical Fixtures
= Duplex Receptacle
.| EWC

i GFCI

... Standard
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11.

12.

13.

14.

15.

16.

17.

i-- Doors

- Duct Syst Type Properties...

i Ducts
Search...

i Electrical
- Electrical Expand All
- Duple Collapse All
o GFCI

. i Standard

| Parameter |

|Defau|t Elevation a0
Switch Voltage 120,00V
Lead Classification Receptacle
Load 600.00 VA
| Lode MName :
Label EWC

el Ready Room @

oM

Save as ex2—1’2.rvt.

Right click on the EWC type.

Select Type Properties.

Set the Default Elevation to 4° 0”.
Set the Load to 600.00 VA.

Scroll down to the Other category.
Locate the Label field.

Set the Value to EWC.

Press OK.

Using the left mouse button, drag and drop the EWC

receptacle family to place it on the wall outside the Room
212 - Men’s Lavatory.

Using the left mouse button, drag and drop the EWC
receptacle family to place it on the west wall in Room 205
— Ready Room.

Using the left mouse button, drag and drop the TV
receptacle family to place it on the south wall in Room
205 — Ready Room.
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Revit doesn’t have a lot of MEP families which work well with creating legends. In this
exercise, we create a detail component family which can be used when creating an electrical
symbol legend.

-xercise 2-13:

Create a Detail Component Family

Drawing Name: none
Estimated Time: 10 minutes

This exercise reinforces the following skills:

o Families
0 Detail Components
0 Detail Lines
o Dimensions
Architecture  Systems  Insert  Annotate  Analyze G . .
1. o Go to Files->New->Family.
D e ¢ Z:‘:‘;:: a Revit project file.
IE open ' % Er-e:zsasetuf(uslnm components
2. Fie name: [Detai Tiem.rft Select the Detail Item.rft template.
Files of type: |Family Template Files (*.rft) Press Open_
3. I k Select Line from the Create ribbon.
Line
4. & On the ribbon:
JJ @ Subcategory:
Detail [tems -]  Set the line style to Heavy Lines.
| Detail Itens |

te .. .
<Invisible lines=

|Heau}r Lines |
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10.

3

Lines (Heavy Lines) (1) « | B Edit Type
Constraints

‘Work Plane iFloor Plan : Ref. Level
Graphics

Visible

3

Visibility/Graphics 0. Edit...
Center Mark Visible |
s 11—

&
o
|
|

™

i7+7i7i

Draw a 1’ radius circle above the horizontal reference
plane.

Select the Circle.
On the Properties palette:
Enable Center Mark Visible.

e

Aligned

— | Use the ALIGNED dimension tool on the Create ribbon
to position the circle 2’ 10” above the horizontal reference
L _ plane.

I Kﬂ Select Line from the Create ribbon.

Line

JJ @ Subcategory:

Detail lterms

| Detail ltems

<|nvisible lines>

|Hea\.-}r Lines

On the ribbon:

Set the line style to Heavy Lines.

Draw a vertical line from the horizontal reference plane to
intersect with the circle.

Use the temporary dimension to position the line 6 left of
the circle’s center.
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1.

12.

)

|
|

A4

|

|-
| [V
Select the vertical line.

Select Mirror - Pick Axis.
Select the vertical reference plane/dashed green line.

-

Reference Planes:
Reference

<|>_7_

A second vertical line is placed.

13.  Save as receptacle symbol.rfa.
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Exercise 2-14
Create a Detail ltem Family

Drawing Name: new family
Estimated Time: 20 minutes

This exercise reinforces the following skills:
o Detail Component families

1. Architecture ~ Structure  Steel  Precast  Systems  Insel GO to File_)New_)Family.
@E' Creates a Revit file.
D e ' E 2:?::5 a Revit project file.
E Open » D Family
Iﬂ gef::si:;:“t)jifdc:stam components
2. ProgramData Browse to the English I folder under Family
Autodesk Templates.
RNT 2021

Family Templates

BN ErEE

File name: | Detail Item.rft

Select the Detail Item template.
Click Open.

Files of type: |Fami|1,||' Template Files (*.rft)

4. I k Select Line on the Create tab.

Line

Draw a square.
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EQ Place a continuous dimension in the vertical

and horizontal direction to center the square

on the insertion point.

To place the dimension, select one line, then
the center reference plane, then the next line,
----- booooooootoo—oo-—t-—- - then left click to place.

Left click on the EQ icon to set the dimension
| equal.

Place an overall horizontal dimension and an
e | o overall vertical dimension.

: To place the dimensions, select the outside
lines, then left click to add the dimension.

213/16"

3

Select the horizontal dimension.

|
2T 191’32"
|
|
ef
EQ , EQ
i fll i
|
|
|
|
& ' &

T
|
|
|

bl On the ribbon:

anet Select New to add a label parameter to the
<None> T dimension.
W
Label Dimension W
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10.

11.

12.

13.

14.

15.

Parameter Data

Name:

[ width | Ome

Discipline:

Common (@ Instance

Type of parameter: [Ireparting Parameter
Length {Can be used to extract value

from a geometric condition and
reportitin a formula or as a
schedulable parameter)

Group parameter under:
Dimensions w

Tooltip description:
«<No tooltip description. Edit this parameter to write a custom tooltip. Custom t...

Edit Tooltip...
|
1 —_ n
Width = 2'- 7 19432
[l
|
|
|
EQ  EQ
|
! .
‘ ‘ ‘
|
|
|
T
|
i
< |
3 v i
= i
&
e il EEEEE e ---
) |
& a !
|
|
I
]
|
|
Label:
<None> -
Label Dimension W
et CApurL..
Parameter Data
Name:
| Depth ‘ O Type
Discipline:
Common @ Instance
Type of parameter: [JReporting Parameter
Length {Can be used to extract value
from a geometric condition and
Group parameter under: reportitin a formula or as a
- - schedulable parameter)
Dimensions =

Tooltip description:
<No tooltip description. Edit this parameter to write a custom tooltip, Custom t...

Edit Tooltip...

Depth =Z'- 2 1318"
i
1
1
1
|
lal
1
1
1
1
1
1
1
|
1

Type Width in the Name field.
Enable Instance.
Click OK.

You should see Width in front of the
dimension value now.

Select the vertical dimension.

On the ribbon:

Select New to add a label parameter to the

dimension.

Type Depth in the Name field.
Enable Instance.
Click OK.

You should see Depth in front of the
dimension value now.
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16.

17.

18.

19.

20.

21.
22.

23.

T Select Family Types from the ribbon.
=
m

|
B =S

Properties
| Set the Default values for the Depth and
Parameter | Walue .
Width to 3° 0.
Depth (default) T 0" Click Apply.
Width (default) 30"

o

The values in the display window should update.

If the values do not update, you did not place the
dimensions correctly. You will need to delete the dimensions
and try again.

Depth =3'-0"

3 Close the Family Types dialog.
I K Select Line on the Create tab.

Line

Set the line style to Medium Lines.
Eg Subcategony:

Medium Lines -

| Déha,-n Oﬁm [reaws  Disable Chain on the Options bar.

Draw two lines to indicate a center mark.

Save as switchboard-section.rfa.

This family will be used in an exercise in Lesson 9.
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Lab Exercises

Create the following legend symbols:

OI _I 8II

00
1
o .
o
| =
= <t
A - 1
. EE _ﬂln . | _____ .o
E:) L | 0'\
| 7%
|
|
SWITCH
\
|
6'- 11"
'ﬁf 3-512" \/
= 7
N P o _ _ _ - ______
\ E::kT \
" ‘
\0" - « ‘
3'-11/4" ‘/ 3 -11/4"
7]
|
PENDANT LIGHT FIXTURE
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EI _ I:III

SCONCE LIGHT FIXTURE
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Notes:
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